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January’s Meeting

February’s Meeting

The demonstration
of Chronos’s
Personal Organizer
by our very own
Rick Matteson
showed the insand-outs of
managing
schedules and
getting organized.
We’ve seen
Rick with his Palm
Pilot. Now, we
know how it passes information back and
forth from Personal Organizer and helps him
keep his life organized.
I liked the to-do aspect of scheduling
reminders in the calendar. I need ways to
remind myself in advance of various deadlines
and family events. Calendar will show you
what’s coming up by your choice of daily,
weekly, and monthly views.
I don’t have my computer dial people by
phone, but Personal Organizer can look up
in its address book link a contact name of
someone to whom you want to speak, and
help you make the call.
Many people have small date-books where
they block out time for meetings, vacations,
etc. Personal Organizer can easily keep up
with their busy life styles, and by entering
future repeating events automatically, they
will save a lot of repetitive data entry. 0
– Donald Hennessy

Write out a check
for $26 for your
dues, come early
to chat, think of
a good question
for Bradley’s Q&A
session and sit in
on your favorite
Special Interest
Group session.
This month’s
guest speaker,
ANDY IHNATKO
Andy Ihnatko,
promises to be a wonderful way to get into
the new year and is a special treat for LIMac
members. You don’t want to miss him.
Andy Ihnatko describes himself as “America’s 42nd most-beloved industry personality,”
chiefly because it’s the sort of claim that’s
vaguely credible but utterly impossible to
entirely verify.
He spent nine years as one of M ACUSER’s
featured columnists, a somewhat shorter time
on M ACWORLD’s masthead, and has also contributed to M ACWEEK , Yahoo! Internet Life,
PLAYBOY and other rags here and there. He
is also the author of three books and The
Original Macquarium, a complete set of plans
and instructions for converting any classic
Mac into a working aquarium (!). 0
Friday, February 9th, Anna Rubin Hall
(Bldg. 300), The New York Institute of
Technology, Old Westbury.

Join the crowd: the annual membership
drive for 2001 is now under way.
Your $26 dues check may be brought to the
meeting or mailed to:
Long Island Mac Users Group
P.O. Box 518
Seaford, NY 11783 0
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The Internet SIG: The Internet SIG meeting will be held at the Bethpage
Public Library (516-735-4113) on Monday, February 19th, at 8 p.m.
SIGs immediately after the general meeting:
Beginners SIG: The SIG will not meet this month so that all of the beginners
will be able to attend Andy Ihnatko’s presentation.
Mac Help SIG: Replacing the internal CD-ROM drive on a G3.
DTP/Photoshop SIG: Show your
good stuff from a floppy disk.
Mutimedia SIG: Making multi-track
QuickTime movies in Premiere.
x LIMac meetings, unless otherwise
noted, are held in Building 300
(Anna Rubin Hall) at the New York
Institute of Technology on Northern
Blvd. in Old Westbury.
| In bad weather, call 516-686-7789.
| The next LIMac board meeting
will be at the Plainedge Library
( 516 -931-3907) on Wednesday,
February 14, at 8 p.m.
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The Seven Best Macs
By Gene Steinberg
Unlike most personal computers from that other
computing platform, the Apple Macintosh is
distinctive and memorable, with devoted users
sticking with them year after year, even though
applications and operating systems have long
since advanced.
Just about any devoted Mac user could
probably come up with seven totally different
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TIP!
Selecting object
with Lasso tool in
Freehand 9 :
Freehand 9 includes a
new Lasso tool that
lets you select anchor
points by surrounding
them. To tell Freehand
to select the entire
object(s) instead of
just the points
contained in the
Lasso’s selection,
double-click the
Lasso and check
Contact Sensitive.
Freehand 9 now lets
you select everything
that’s not currently
selected by choosing:
Edit>Select>Invert
Selection.
–Step-By-Step
Electronic Design

selections with equally valid reasons for the
choices. Our specific criteria include innovative design, great performance, visceral
appeal and, as much as possible in this rapidly
changing industry, enduring the test of time.
Macintosh 128K The original,
compact, quintessential Macintosh.
Foreshadowing the iMac that came
14 years later, the 128K had the computer and display — all nine inches of it — in a

single, small, distinctive looking case. Just plug in
a keyboard and mouse, insert a floppy (they had
no hard drives!) and you were ready to compute.
It was a computer operating like no other. Instead
of typing commands, you pointed and clicked. The
last and much faster incarnation of the original
design, the Macintosh Color Classic, is to this
day a cult classic, cherished by
thousands of loyal users worldwide.
Macintosh II ). The first truly

expandable, modular Macintosh. Everything was
a la carte. You had to buy a monitor plus a
graphic card to run it. Graphic designers adored
it, because, at long last, they could see their work
in full color.
Macintosh IIci While some professionals prized the fastest of the
original Mac II series, the IIfx, the expandable lowprofile IIci was the real winner. Although not as fast
as its eccentric big brother, you could easily speed

President’s Message

Technical Corner

We are hoping.
OS X is supposed to be the biggest change
since the Mac was introduced seventeen years
ago and it is supposed to run on a limited
number of Macintosh computers. Some say
this is terrible and shows no consideration for
the Mac owners with older machines. Maybe,
we should wonder what they are running and
how slow it must be. The Mac is not a $6000
machine any longer; there are machines out
there that are very fast, will run OS X and are
very affordable.
Life in the fast lane can be much more fun
and it is something you should consider. After
all, this is the twenty-first century. 0

| I want to buy a new G4 . What are the
advantages of buying a new faster G4 or
buying the older dual processor models?
The dual processor models right now will
be slower in the majority of applications
that cannot take advantage of multiprocessing.
Adobe Photoshop 5.5 or 6.0 take advantage of
multiprocessing and the Altivec feature of the
G4. A dual 450 will work at 140% of a single
450MHz model or about as fast as a 630MHz
model when it’s making use of the two processors, which may be only a relatively short
amount of your work day, depending very
much on the specific filters and operations
in Photoshop. Overall at $2,800 a forthcoming
667MHz G4 will be faster for somewhat more
money than a dual 450MHz model, and be
faster all the time, not just sometimes. It also
offers one additional PCI slot, faster R AM ,
bigger hard drive, a more useful CD-RW compared to a DVD-ROM (unless you have DVD
based clip art) and a higher performance
video card. As this was written, there was
a 7- to 10 - week wait for this model. The
older dual 450 models with a bundled extra
128MB of R AM goes for $2,000 with overnight delivery. Still a nice machine. The dual
processors will really be a big benefit when
you use Mac OS X in the future, since the
preemptive multitasking can properly use the
dual processors so you really can run two
programs at once, with the usual slowdowns
or stalling of the background applications.
Perfect in the situation when you run QuarkXP ress and Epson Stylus RIP for your printer,
lets say. Or even when your downloading
MP3s with Napster while playing Star Trek
Elite Force or Reckless Drivin’. The decision
becomes tougher if you compare the now shipping 533MHz at $2,200 versus, the dual 450.
The new model comes with Mac OS 9.1, which
may cause a few problems at first, so the
older model is a safer bet if you can’t wait
and don’t want to spend the bigger bucks for
the 667MHz model. On the 2001 G4 s, there’s
no longer a monophonic analog input (normally used for a microphone), so depending
on what you do with your Mac, that may
make a difference. The built-in CD-RW sure
is nice though. It all depends on the very
specific task or tasks you do. For right now,

LIM ac’s FORUM has been awarded the User
Group Academy Awards Special Judges’
Citation of Excellence.
From the
User Group
award:
“The Long
Island Mac
Users
Group
is the premier
Macintosh
user group
for the
entire Long Island, and New York City region.
Their newsletter, THE FORUM, is a two-time
Academy Award winner, and winner of the
User Group University Newsletter contest in
July of 2000. It’s also the only newsletter
entered which complies to the true definition
of newsletter. Using a Beige Macintosh G3,
InDesign, Illustrator, Photoshop and Tex-Edit+,
Editor/Designer Mo Lebowitz produces this
monthly newsletter for more than 250 readers.
“THE FORUM was singled out by this year’s
judges for consistent excellence in both publishing discipline and quality of content. It
is scheduled to be featured in an upcoming
DTG M AGAZINE article in The Design & Publishing Center at www.graphic-design.com.” 0
[The Editor would like to thank all the members
who have contributed their time and expertise,
without which, there would be no awards. All
members are invited to submit material.]
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Bradley Dichter
bdichter@cdr.net

TIP!
Adobe Acrobat’s
annotations:
Acrobat’s annotations
are a handy way to
keep track of your
thoughts as you
review a PDF document. To get the most
from this feature, try
these tips:
In Acrobat 4,
choose Tools>Annotations>Filter
Manager to choose
the type of annotations you want to
view. You can also
view annotations by
author. For a list
of all the annotations in a document using Acrobat
4, chose Window>
Show Annotations.
Click the button at
the bottom of the
Annotations pane to
scan the entire document for annotations, then double
-click any annotation
in the list to go to
that page. To review
just the annotations,
open the document
and choose Tools >
Annotations> Summarize Annotations.
To print annotations
in either Acrobat or
Reader, check the
Annotations box in the
Print dialog box.

it up to the PowerPC level.
Quadra 840AV This wasn’t so much
a computer as a test bed for new
technologies. It had a pair of onboard
digital signal processors that allowed this baby to
process digital audio and emulate the functions of
a modem. The first iteration of Apple’s PlainTalk
software allowed you to give this computer simple
commands. The most innovative feature, though,
was its onboard video input and output ports. You

could actually watch TV on your Mac, and even do
simple desktop video editing chores.
Power Macintosh 8100 Apple did
the impossible with this model. They
moved their computers to a totally
new line of processors, yet managed
to maintain near-seamless backward compatibility
— a miracle they hope to perform again with the
forthcoming Mac OS X. The first Power Mac found
its way into the hands of graphic designers and

video professionals alike. In fact, noted special
effects artist John Knoll, of Industrial Light and
Magic, used his 8100/80 to create some of the
special effects we know and love on such films as
“Star Trek: Generations.”
iMac The prodigal son of the
Macintosh 128K has become
the symbol of Apple’s resurgence.
The melange of translucent and
transparent plastics wasn’t the only unique aspect

of this consumer-oriented personal computer.
Gone is the drab beige of old, replaced by a slew
of cool colors, from the original Bondi blue, to the
snow white of the latest models.
PowerMac G4 Cube The little marvel stands less
than 10 inches high in its transparent case and
the silver gray internals are 7.7 inches square.
This computer is designed to appeal to your
emotions. 0
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More Technical Corner

TIP!
The four primary uses
of the term desktop:
desktop:
This term, normally
lowercase, refers to
the central work area
on your monitor’s
screen after you start
up your Mac. This is
where the desktop pattern or desktop picture defined in the
Appearance Control
Panel appears.
Desktop file:
Rebuild the Desktop
refers to this invisible
file that stores information about the contents of your hard disk.
Desktop Folder:
(Mac OS 9 and earlier
only.)
When you leave items
on the desktop, they
are stored in an invisible folder on the hard
disk named Desktop
Folder. Items stored
there exclude the
Trash and any disk
icons that appear on
the desktop.
If you have more
than one hard disk
or hard disk partition,
the Mac OS creates
an invisible Desktop
Folder on each disk
or partition. This
also applies to
removable media.
Desktop folder:
(Mac OS X Public
Beta only.)
Each user with an
account on a Mac OS
X Public Beta computer has a folder
named Desktop in his
home directory.

pre-Mac OS X , the faster single processor is
best. At the Apple Store you can order a
dual 533MHz model, for $300 more than a
single 533. This would be a nice balanced
machine for a Mac OS X user or someone
who heavily uses multiprocessor accelerated
functions, where it can be as fast as a
733MHz model for $1000 less, neglecting the
DVD-R , bigger hard drive, and the effect of
the faster R AM and memory bandwidth (and
128MB more memory) the forthcoming new
733MHz model will have. I see heavy CAD
users making good use of multiprocessors on
the PC with AutoCAD and Windows NT, so
under Mac OS X , a multiprocessor CAD/3D/
animation machine should be rather snappy.
| I have an iMac 350 with MS O ffice ’98 ; in
Word, the arrow keys don’t function.
I couldn’t reproduce that. I suggest besides
the Combined Updater for Office ’98, you
should try also installing Office ’98 Update
for Mac OS 9.0 and MS Office ’98 Updater or
buying the Word 2001 upgrade and installing
that. You also may try disabling potentially
conflicting Extensions/Control Panels and reinstalling and re-updating Word ’98 . If you
have the special edition of Word for iMac,
it still needs those updates other than the
combined one. Remember the iMac predates
Mac OS 9. The first iMacs came with Mac OS
8.1 even. If you also have Excel ’98 , there was
a Excel 98 Y2K Update, too.
| I have an iMac 350, using PageMaker,
Illustrator and Photoshop for personal
use. Can you recommend a printer and
scanner? I can create a PDF file and avoid
having to have Postscript ability.
Epson Stylus Color 980 is good at $200 or
the HP Deskjet 970C se at $300 has the edge
for printing text. For a scanner, the Microtek
ScanMaker 3700 for $90 is reliable. For a step
up, I’d suggest the ScanMaker 4700 at $200.
It’s 1200 dpi is best when scanning small
areas and blowing them up to full size. For
only $200 it does a fantastic job, only hampered by the required slow USB port when
scanning at high resolutions.
| Whenever I use Internet Explorer 5, I
keep getting a message saying I need
MRJ 2.0 or later, but I have 2.2.3.
What’s wrong? I noticed an Extension:
MRJenabler.

It’s probably damaged. Download version 2.2.4 ,
delete the MRJ Libraries folder in your System
Folder:Extensions folder and install the new
update. Then start Explorer. Make sure the
Preferences are set to enable scripting, plug-ins
and Active X under Web Content and Enable
Java (Apple MRJ ) is checked under Java. The
MRJenabler is for the old version of Netscape
Communicator. The current release 4.7.6 uses
MRJPlugin 4.X . Don’t use Netscape 6 .
| I’m now running a G3 with Mac OS 9.
Should all programs still work if I switch
to a G4 ?
Not quite all, I would guess. If you buy a
brand new 2001 G4 , it comes with and
requires Mac OS 9.1, so I would expect a few
items won’t work. An older G4 will come with
Mac OS 9.0.4 , so you’d have a few less problems.
Also, if you are using Norton Utilities or
TechTool Pro, you may have to get an updated
CD to boot the G4. The latest releases come
with 9.0.4 , so it will work with the older G4 ,
not the very latest. It will be a couple of
months before a new CD is available.
| The color on two monitors I have near
each other are quite different. What can I
do to fix this?
If the two monitors are of a different nature,
like one is a Trinitron/Diamondtron and the
other is not, it will be harder to match them.
Also if one is older, it’s color may be fading or
shifted. There could also be a misconvergance
on an old monitor, which would shift colors
and make things fuzzy with color flares to one
side. You should first set them to the same
white point if possible. Most people shoot for a
6500K white point or color temperature. Low
end monitors do not allow you to make a
change. Also you should have the contrast
at maximum. Then use the Monitors Control
Panel to help adjust the brightness of the monitor and the gamma the Macintosh uses and
the relative strengths of the RGB values.
Then review the same choices, if you
have it, use Adobe Gamma or the old
Gamma Control Panel that comes with
Adobe Photoshop. Finally, make sure the
ColorSync Control Panel(s) are set to use the
new ColorSync profiles
created before. If you use Quark XP ress 4 .x,
also change settings in the Pantone Profile
Control Panel. 0
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TSK,TSK!
Quark replies to a
Photoshop-to-Quark
clipping paths
problem:
QuarkXPress does not
recognize Photoshop
6 EPS clipping paths.
Here is a reply on this
matter from Quark:
“There is no
workaround for this
problem, other than
downsaving the
Photoshop 6.0 files
into the 5.5 or earlier format. We are
communicating with
Adobe to figure out
what can be done
about this situation.
And yes, one does
wonder why Adobe
never bothered to
communicate this
issue to us during
the Photoshop 6.0’s
development or betatesting.”
When asked
about the above,
Adobe said it’s the
responsibility of the
application that’s
importing the
Photoshop file (i.e.
QuarkXPress) to fix
this.
[Let’s get together on
this, boys and girls!
– Editor]

Long Island Macintosh Users Group
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www.limac.org
This month’s guest speaker,
Andy Ihnhatko, promises to
be a wonderful way to get
into the new year and is
a special treat for LIMac
members. You don’t want to
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Andy Ihnatko describes
himself as “America’s 42nd
most-beloved industry
personality,” chiefly because
ANDY IHNHATKO
it’s the sort of claim that’s
vaguely credible but utterly impossible to verify.
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Helen and
Sheldon Gross
shel9 @ bellatlantic.net
Note: These sites are
referred to by us for
your information only
and neither we nor
LIMac endorse any of
the products or sites.

Sore Eyes

URL Manager Pro

It’s cold and so we’ve decided to cut our
losses and take a visit to a warm location.
For me, this is the time to prepare for e-mail
when traveling. Our DSL connection does not
provide a call in phone number, so that getting on the Web requires all sorts of manipulations. This is the only time of the year when I
regret using a Mac.
There are no simple solutions to this
problem. While traveling, the best solution
to ISP connections is AOL . They seem to
have the largest and most convenient collection of local access numbers. Unfortunately, it
requires the largest outlay of dollars, as well.
We keep looking for alternate solutions.
We’ve been unable to find a free ISP connection for use with the Mac. Companies keep
promising that they will be available, but do
not seem bring their claims to fruition. No
such luck. Our DSL provider, Verizon, makes
the e-mail available but you must get on the
Web to take advantage of it.
That’s the problem. First, we visit any and
all of our friends in the area with computers.
A few minutes on line allows us to read and
reply to the e-mail.
Next, we go to public libraries. We can get
on line almost anywhere at no charge. Then
we respond to our mail. Most libraries limit
visitors to 30 minutes, but with two people,
we can get an hour at a time, and that solves
the problem.
Hence, this commentary. Perhaps others
have further suggestions. We’d like to know.
There’s still hope!! 0

Are you constantly switching
from Netscape to Internet
Explorer ? With the way
browsers act these days you
probably do a bunch of
switching around. Unfortunately, switching
browsers isn’t exactly the easiest thing to do.
Mainly because you have to transfer bookmarks from one browser to another. It may be
easy to do, but it becomes a real pain after a
while. URL Manager Pro solves that problem
and offers some great enhancements.
URL Manager Pro manages all your bookmarks in one program. The reason I like URL
Manager Pro the best is because of its interface. The program allows you to create folders
for each category of your choice. You then
have the option of adding individual URL s
to each folder. You can even add sub-folders.
The program integrates with your current
Web browser so you don’t have to jump back
and forth between applications to paste new
URL s. It also supports e-mail, and ftp/URL
protocol. One of the nicer features of the
bookmaking system is the ability to place
notes with each URL . By highlighting a bookmark and pressing Command-I you have the
option to place your own notes about the
selected site.
Powerful Features:
History. This is similar to the function in
Internet Explorer that keeps track of past sites
that you visited. URL Manager Pro can automatically check for dead URL s. The program
also has a built in Net Search.
Download: www.url-manager.com.
Registration fee is $25.00. 0
–Dennis Sellers
(User Groups News will return next month.)
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TIP!
Avoiding scan showthrough:
Avoid having your
scanner pick up text
or art from the back
of the sheet you are
scanning (called
ghosting) by placing
black paper behind
the sheet you’re
scanning. The black
paper stops light that
would otherwise shine
through the paper,
thus eliminating any
show through.
Some scanners
already have a black
inner lid to prevent
ghosting.

